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Important information
The Axicon 6000-W Laetus (Pharmacode) verifier has been specifically designed to 
verify Laetus (Pharmacode) barcodes. As the symbol has been designed to be read 
by a white light source this verifier uses white light. This verifier cannot be used to 
verify any other barcodes.

The verifier is a high precision opto-electronic device and should be handled with 
due care. Please use the plastic case to protect the equipment when not in use.

Only use cables and other accessories supplied by Axicon as the use of non-approved 
accessories will invalidate the warranty.

If the verifier is dropped (or subjected to similar accidental damage) the accuracy 
of the results may be affected, so please return it to us for servicing. We also 
recommend that it is factory recalibrated annually.
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Introduction
What is in the case.

• Axicon 6000-W verifier with USB cable.
• Software CD.
• Wallet containing this user guide and calibration card.

The Axicon 6000-W is designed to work with any PC running a version of Microsoft 
Windows currently supported by Microsoft.
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Installation
Please do not connect the verifier at this stage. The software should be installed 
before the verifier is plugged into a USB port on the computer.

You will need to install the Axicon linear verifier software before the Laetus 
software.

To install the Axicon linear software, insert the CD into your computer’s DVD drive. 
The program should run automatically, but if not, open the CD using Windows 
Explorer, double-click the Autorun Program, and click on Install Axicon Verifier. 
Follow the on-screen instructions, and after you have clicked on the Finish button, 
leave the software CD in the PC in order to install the USB drivers.

After installation is completed you will find the Axicon Verifier directory in Start 
Menu/Programs and a shortcut to the program on your desktop.

To install the Laetus software, use the Windows File Explorer to locate the software 
CD in your DVD drive, and right click on it to open the contents. Select the Laetus 
1.0.8.0 folder, right click on it and save it to your computer. Now go to this 
location, open the folder, and left click on the Laetus application file. The program 
will now start, and the following command window will appear.
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To place a shortcut for the program on your desktop or in your task bar, right click 
on the Laetus application file again, and the appropriate options will appear.

Now plug in the Axicon 6000-W to your computer so that the USB driver can be 
installed. The software should detect the verifier and turn it on so that the white 
LEDs are all illuminated. The text at the bottom of the command window, Laetus 
Decode should read Reader ABCD activated!, where ABCD is the serial number of 
the verifier.

If the verifier is not found, click on Reader then Reset Reader from the dropdown 
menu, or press F3. You will need to choose the verifier (identified with its serial 
number), then click on Activate.

Double click on the Laetus shortcut on the desktop to start running the program.
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Calibration
The calibration process for the Axicon 
6000-W verifier is carried out using 
the Axicon Verifier program and not 

the Laetus program. The calibration records 
are however accessible by both software 
programs.

Calibration should be carried out after 
installation and at regular intervals. You will 
need your calibration card which should be in 
your documentation wallet. 

Use the EAN-13 calibration code at the top of 
the card. 

Calibration is a quick and simple process. 
Select Calibrate from the Options menu 
of the command window (or press F2). You 
will see a window with two edit boxes for 
minimum and maximum reflectance values. 
Ensure that the values shown in the window 
match the values printed at the bottom of 
the calibration sheet. Modify the figures on 
the window if necessary to ensure that they 
are the same as those printed on the card.

Please note that the Summary window will now show Error alongside Structure and 
highlight the box in red. This is not an error when the 6000-W is calibrated. 

With the Calibration window open scan the calibration barcode 10 times. Then click 
the OK button. The verifier is now calibrated and ready to use. After calibration, 
store the calibration sheet in the documentation wallet, away from light and 
physical damage. 

After calibrating the Axicon 6000-W please close down the Axicon Verifier program 
and start the Laetus program.

Calibration Card

( )

GS1-128

EAN-13

Serial Number:

This card is NIST traceable

In service date:

Data Matrix

Expiry Date:
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With the verifier in contact with the barcode, press the button underneath the 
reader, or from the menu on the command window choose Reader, then Get Scan, 
or use Ctrl + G. Read the barcode only once.

The Laetus Decode window provides the binary pattern data followed by the value 
of the data, and shows this in both directions. All the measurements are expressed 
in µm (thousandths of a millimetre), and the entries are coloured green or red 
depending on whether they are in specification. An image of the symbol that has 
been read is also shown in the window.

Using the 6000-W
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The Average Bar row provides the width of the wide bars then the width of the 
narrow bars, and then the wide bar width to narrow bar width ratio.

The Average Space row provides the width of the narrow space, then the width of a 
wide space if one is present. The last entry provides a count for the number of wide 
spaces. The Nominal (Standard) section provides the nominal measurements for all 
these elements, again expressed in µm. 

The Product Lookup will always display Not Found! with a red background if this 
has not been established as explained below.

The Laetus Dimensions window provides more information about the symbol. Click 
on Options in the main window, then choose Show Dimensions from the dropdown 
menu, or press F11 to open it.

The bar graph shows the bars and spaces in terms of their deviations from their 
nominal values. When these measurements are within the tolerances allowed by 
the Laetus specification, the elements are shown in two tones of green. Dark green 
represents the bars, and pale green represents the spaces.

When the symbol does not conform to the Laetus specification the bar graph may 
look something like this (below). The elements in red (darker for bars, paler for 
spaces) are out of tolerance, with the spaces here shown in pale red being too 
narrow.

Using the 6000-W
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The table below the bar graph provides the measured width of each element, 
together with its nominal width, its deviation from this, and its reflectance value.

The verifier does not give a grade to the barcode as there is no published standard 
for grading.
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The software has a Product Lookup facility and it will automatically attempt to 
locate the Laetus code in the lookup file and display the description of the product. 
The product look-up file can be examined and edited by pressing the F7 function 
key or selecting the lookup function from the Options menu.

When a code is not found in the table, it can be added to the lookup table by 
ensuring the correct code is in the Edit Description field and clicking the Add 
button. This will bring up a dialogue box into which a description can be added. 
Once this has been done, then the next time this code is scanned the description 
from the lookup file will be shown on the command window.

Product Lookup
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Press F5 or from the command window click on Options then Setup from the 
dropdown menu to open the Setup window.

The Settings tab allows you to switch between standard Laetus codes and 
Minicodes. The verifier will also automatically look for supplementary codes, but 
this can be changed by unticking the Automatic box and then you can select the 
number of coloured bars manually. 

The Calibration tab allows you to change the file where all calibration records are 
kept. This must be the same file as that used by the Axicon Verifier software. The 
Decode tab is only for use by Axicon, and all options are unavailable.

Setup



Axicon 6000-W

Page 14 of 20

Axicon Auto ID Limited  |  Pharmacode verifier user guide | August 2020

Saving and printing

When you have verified a barcode, click on the File menu on the command window 
and choose Save from the drop down menu. These records are created as .bpc 
files. When you want to print out a report, go to File and then choose Print from 
the drop down menu. The report will be headed Axicon Binary Pharmaceutical 
Code Verification Report and includes information from both the command and 
dimensions windows. The report does not include the image of the barcode or the 
bar graph of deviations.
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Software licence agreement
This software is Copyright © Axicon Auto ID Limited
Use of the software is subject to the Axicon software licence terms set out below. 
Using the software indicates your acceptance of these licence terms. If you do not 
accept these within 14 days, you may return the entire unused product for a full 
refund. 

Axicon grants you a licence to use any number of copies of the software, but only 
for use with an Axicon verifier. “Use” means storing, loading, installing, executing 
or displaying the software. You may not modify the software or disable any of its 
licensing or control features.

Ownership
The software is owned and copyrighted by Axicon Auto ID Limited. Your licence 
confers no title or ownership in the software and is not a sale of rights in the 
software.

Copies
You may only make copies of the software for archival purposes or when copying is 
an essential step in its use. You must reproduce all copyright notices in the original 
software on all copies. You may not copy the software onto a bulletin board or 
similar publicly accessible system.

No disassembly or decryption
You may not disassemble or decompile the software without prior written consent 
from Axicon.

Transfer
Your licence will automatically terminate upon any transfer of the software. 
Upon transfer, you must deliver the software, including any copies and related 
documentation, to the transferee. The transferee must accept these licence terms 
as a condition of the transfer.

Termination
Axicon may terminate your licence upon notice of failure to comply with any 
of these terms. Upon termination, you must immediately destroy the software, 
together with all copies, adaptations and merged portions in any form.
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Export requirements
You may not export or re-export the software in contravention of any applicable 
laws or regulations.

This agreement should be construed in accordance with the laws of England.

DISCLAIMER 
In the following the expression “verifier” means the verifier hardware and the 
associated software.
 
We have taken care to ensure that this verifier is free from defects. However since 
we have no control over the circumstances in which you might use it you must 
satisfy yourself that it is suitable for your needs. Neither Axicon Auto ID Limited 
nor the vendor of this verifier can accept any liability for any loss or damage 
(consequential or otherwise) which may be caused by its use. 

If the verifier or any part of it is defective in any way, or in some other way does 
not meet your expectations, the liability of Axicon Auto ID Limited is limited to the 
cost of the product. You should bear this limitation in mind if you use this verifier 
in any situations where the acceptance or rejection of shipments of goods or your 
reputation may depend upon the quality of a barcode.

Software licence agreement
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Warranty
The 6000-W verifier is sold with a two year parts and labour warranty against 
manufacturing defects. This is a return to bench warranty with shipping costs in one 
direction being borne by the customer/distributor.

Should you need to return the unit to Axicon the original case (plus appropriate 
packaging) must be used. If the equipment is returned without the original case, we 
will automatically charge an additional sum for its replacement.

Axicon’s standard repair turnaround time is 7-10 working days. This standard 
warranty does not include the provision of a loan unit. Loan units can be supplied 
on request.

Axicon reserves the right to charge an inspection fee for any equipment returned 
under warranty for which no fault is found. Please contact us to obtain an RMA 
number before returning any equipment. This number must be quoted on all 
documentation. We cannot accept responsibility for equipment returned without an 
RMA number.
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Service contract 
A service contract may be purchased within 30 days from the date of despatch. 
This allows you to return your verifier back to us at no extra cost for its annual 
VCAS (verifier conformance and alignment service) so that you can be sure it still 
measures barcode quality in accordance with the requirements of ISO/IEC 15426-1.

The service contract will also extend the warranty beyond two years, so that if it 
breaks down, all parts and labour will be provided free of any extra charges. The 
only exception is when the verifier has been misused, in which case labour costs 
will be covered, but not those of the parts.
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Annual service conformance
All verifiers need servicing every year to ensure that they measure barcode quality 
in accordance with the relevant ISO/IEC standards. This verifier conformance and 
alignment service (VCAS) ensures that the verifier is internally dust-free, checks 
that it is focused correctly, and re-calibrates the hardware to account for any 
change in the brightness of the LEDs used to illuminate the barcodes.

This annual service is not the same as user calibration, as it looks at the output of 
the LEDs and corrects for any variance in their evenness of illumination across the 
whole field of view. Over time the LEDs will fade but they will not fade uniformly. 
User calibration ensures that the verifier is measuring the darkest and brightest 
reflectances correctly but it cannot correct for any variance in the illumination.

After your verifier has been serviced, we will return it you with the latest version 
of the software on CD together with a new calibration sheet, and a new user guide 
that will include the new certificate of ISO/IEC conformance. You will then need 
to calibrate the verifier before you use it again. The latest software can always be 
downloaded free of charge from our website, www.axicon.com.

To arrange for your verifier to be serviced:

1. Contact us on 
 Telephone: +44 (0) 1869 351155 | Fax +44 (0) 1869 352404 
 Email: vcas@axicon.com
2. We will provide you with an RMA number (Return to Manufacturer Authority)  
 and an RMA form.
3. Please fill in all details requested on the RMA form, including the RMA number.
4. Return the verifier (including all cables) in its original case with the completed  
 RMA form, purchase order and your payment details to us at Axicon Auto ID  
 Ltd, Church Road, Weston on the Green, Oxfordshire OX25 3QP. We cannot take  
 responsibility for units returned in alternative packaging.
5. We will normally complete the service and re-calibration of your verifier within  
 7-10 days.



Contact us
Axicon Auto ID Ltd 
Church Road
Weston on the Green
Oxfordshire 
OX25 3QP
UK

Tel:  +44 (0) 1869 351 155
Fax:  +44 (0) 1869 351 205
Email:  info@axicon.com
Website: www.axicon.com

As Axicon continually improves its products, their specifications and features are 
subject to change without notice. All trademarks are acknowledged as belonging to 
their respective companies.

Your Axicon distributor


